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Materiaty szkoleniowe w formie zeszytu ¢wiczen zostaty opracowane dla wersji QGIS 3.4
LTR, ktora byta rowniez wykorzystywana podczas szkolenia.

Cwiczenie 1. Zakladanie, konfiguracja i zapis
projektu

Tworzenie projektu

Projekt QGIS stuzy do przechowywania ustawien i konfiguracji definiowanych w
oknie programu. Przechowuje miedzy innymi takie informacje jak:
ilos¢ i kolejno$¢ warstw,
symbolizacja warstw,
uktad wspoitrzednych projektu,
ustawienia kompozycji wydrukéw.

Aby utworzy¢ nowy projekt nalezy klikng¢ na przycisk “Nowy projekt” D na pasku
narzedzi lub wybrac¢ z menu “Projekt” pozycje “Nowy”.

Konfiguracja projektu

Projekt mozna skonfigurowa¢ korzystajac z jego wtasciwosci, kidre sa dostepne z
poziomu paska menu w pozycji “Projekt’ > “Wlasciwosci’. Okno oferuje kilka zaktadek
zawierajgcych poszczegdlne ustawienia:

e Ogolne - stuzy do definiowania podstawowych wiasciwosci tj.: tytut i lokalizacja
projektu, wybér jednostek do pomiaru oraz sposobu wyswietlania wspétrzednych

e Metadane - pozwalajg na wprowadzenie bardziej szczegotowych informacii
opisujacych dany projekt

e Uklad wspoitrzednych - umozliwia zdefiniowanie uktadu wspétrzednych projektu.

Domys$lnie QGIS przyjmuje uktad WGS84. Aby pracowa¢ w ukfadzie lokalnym,

nalezy zadeklarowac¢ odpowiedni ukfad wspotrzednych, we wiasciwosciach projektu.

Aby wskazaé¢ uktad wspotrzednych nalezy wybra¢ go z obszaru “Dostepne uklady

wspotrzednych” i zatwierdzi¢ wybor przyciskiem “Zastosu;j”.

W celu szybszego znalezienia wlasciwego uktadu mozna postuzy¢ sie pozycja “Filtr”,

wpisujagc kod ESPG lub nazwe kraju dla ktérego majg zosta¢ wyszukane ukfady

wspotrzednych.

Najpopularniejsze ukfady wraz z kodami EPSG:

e WGS 84 - 4326
e PUWG 1992 - 2180
e PUWG 2000 (strefa 5-8) - 2176 do 2179
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Wtasciwosci projektu | Uktad wspotrzednych

uktad wspétrzednych projektu (CRS)
>4 ogélne : . ol : :
\ Og Bez odwzorowania (lub nieznane/nie-ziemskie odwzorowanie)

m Metadane

@ Uktad wspotrzednych
% Domyslny styl

B Zrodta danych

“ Relacje

Zmienne

,_,@ Makra

Filtr | &
Ostatnio uzywane uktady wspétrzednych
Uktad wspétrzednych

* Wygenerowany uktad wspétrzednych (+proj=tmerc +lat_0=0 +lon_0=19 +k=0.99... USER:100025

ETRS89 / Poland €S2000 zone 5
WGS 84

ETRS89 / Poland C52000 zone 6
«

Dostepne uktady wspatrzednych

Uktad wspétrzednych
Voirol 1879 (Paris)
WGS 66

Authority ID

EPSG:2176
EPSG:4326
EPSG:2177

Authority ID
EPSG:4821
FPSG:4760

»

Ukryj nieaktualne

- 1 v
QGIS Server
wybrany uktad |WGS 84

Zasieg: -180.00, -90.00, 180.00, 90.00
Proj4: +proj=longlat +datum=WG584 +no_defs

Transformacje uktadu odniesienia
| [=)]/
Zrodtowy uktad wspétrzednych  Zrédtowy uktad odniesienia = Docelowy uktad wspétrzednych Docelowy uktad odr

[l >

«f Zastosuj || % Anuluj oK ‘

@pPomoc

e Domyslny styl - stuzy okresleniu domysinej wizualizacji danych wektorowych, ktére
bedg wczytywane do danego projektu
Zrédta danych - wyswietla informacje na temat warstw wczytanych do projektu
Relacje - stuzy do definiowania relacji miedzy warstwami
Zmienne - wyswietla podstawowe informacje dotyczace srodowiska pracy (system,
wersja programu, nhazwa autora itp.)

e Makra - umozliwia tworzenie modutdéw Pythona, ktére beda wywotywane przy
otwieraniu, zapisywaniu i zamykaniu projektu.

e QGIS Server - umozliwia definiowanie ustawien dla projektu w celu publikacji go w
formie ustug sieciowych (WMS/WFS)

Zapis projektu

=]

Aby zapisa¢ projekt nalezy klikng¢é na przycisk “Zapisz projekt” na pasku
narzedzi lub wybra¢ z menu “Projekt’ pozycje “Zapisz’. Nastepnie w oknie dialogowym
nalezy wskaza¢ lokalizacje pliku oraz podaé¢ jego nazwe i catos¢ potwierdzi¢ przyciskiem
“Zapisz’.

QGIS dysponuje dwoma formatami projektu:

e QGZ - nowy format projektu, utatwia on dotgczanie do projektu plikow SVG i
GeoPackage, a takze skryptéw, skali barwnych czy wtyczek. Umozliwia réwniez
okreslenie szczegotowych metadanych dotyczacych projektu.

e QGS - stary format projektu, daje bardziej ograniczone mozliwo$ci zapisu ustawien
niz format QGZ.

Przeglad wtyczek wraz z wykorzystaniem

W pasku menu znajduje sie pozycja ,Wtyczki’. Na poczatku listy znajdujg sie dwa
pola, czyli ,Zarzadzaj wtyczkami’ i ,Konsola Pythona” (dla oséb znajgcych jezyk
programowania PYTHON i chcg obstugiwa¢é QGIS 2z linii komend), a dalej lista
zainstalowanych oraz aktywnych wtyczek.
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Aby zainstalowac wtyczke nalezy klikng¢ ,Zarzadzaj wtyczkami”:

Wtyczki | Wszystkie (320)

“ Wszystkie Q szukaj...
— . # __MACOSX [= i i
E 3 zainstalowane »_ Wszystkie wtyczki
i | Lista tkich wty k dost h dia tej ji QGIS.
D s 2 ista wszystkich wtyczek dostepnych dla tej wersji .
Niezainstalowa & Advanced Line Editor obejmujaca zaréwno te zainstalowane, jak i dostepne do pobrania.
. # agknow for QGIS Niektére z wtyczek s3 dostarczane z programem, lecz wigkszosc z
Aktualizowalne % AmigocCloud nich udostepniana jest poprzez repozytorium wtyczek.
i Animate OSM Mozna tymczasowo wigczyc lub wylaczyc wtyczke. Aby wtyczke
& Niesprawne & Animate wigczyc lub wylaczye, kliknij na pole wyboru lub dwukrotnie kliknij
Instaluj z pliku &4 = Another DXF Importer / || na nazwie wtyczki.
ZIP i Append Features to Lay Wtyczki wyswietlone na czerwono nie zostaly wczytane, poniewaz
- - jest z nimi jakis problem. S3 one réwniez wyswietlone w podgrupie
# AQUaGIs Plugin wtyczek "Niesprawnych". Kliknij na nazwie wtyczki, aby przeczytac
v| % Area Along Vector jej opis, przeinstalowac ja lub odinstalowac.
% arrayPlus

4 Asistente LADM_COL
# Attribute painter

@ AttributeAssignment
# AustrianElevation

i autoSaver

# Azimuth and Distance C - m
+ || Aktualizuj wszystkie
@ Daksh CRC Innarckar

| @Pomoc 3 Zamknij

Najwazniejsze informacje to nazwa, wersja wtyczki oraz krétka informacja o niej.
Wtyczki instalowane sg ze specjalnych repozytoridow, czyli miejsc, ktére QGIS sprawdza za
kazdym razem przed uruchomieniem instalatora w poszukiwaniu nowych narzedzi i
aktualizaciji istniejgcych. Wystarczy podswietli¢ wybrang pozycje i klikng¢ ,Zainstaluj”.

W niektorych przypadkach nalezy doinstalowa¢ do QGIS dodatkowe biblioteki aby
wtyczka dziatata poprawnie - o tym uzytkownik jest informowany przez instalatora. W
przypadku uzywania instalatora OSGeo4W — uruchomi¢ instalator i zaznaczy¢ brakujace
biblioteki do instalacji. W innym przypadku biblioteki trzeba pobrac¢ z sieci i umiesci¢ we
wiasciwym katalogu na dysku, lub skorzysta¢ ze specjalnego narzedzia do instalacji wtyczek
o nazwie PIP.

Instalator wtyczek skfada sie z siedmiu zaktadek. Istotna jest zaktadka ,Ustawienia”:

- "
() Wiyczki | Ustawienia -

["] Poszukuj aktualizacji -
nstalowane przy kazdym starcie programu -

Uwaga: Jesli ta funkcja jest wiaczona, QGIS bedzie informowat Cie gdy tylko pojawi sie nowa wtyczka lub uaktualnienie jednej z
W Niezainstalowane zainstalowanych. W przeciwnym wypadku, sprawdzanie repozytoriéw bedzie nastepowad dopiero przy otwieraniu Menedzera.

*  Niesprawne v [] Pokazuj wtyczki eksperymentalne

Uwaga: Eksperymentalne wtyczki generalnie nie sg przeznaczone do codziennego uzytku. Sg na wczesnym etapie rozwoju i
powinny by¢ traktowane jako nieckompletne lub koncepcyjne. Zespdt QGIS nie zaleca instalowania ich w celach innych niz
testowe.

aluj z pliku

m

;7:; Ustawienia

v [ Pokazuj wityczki niezalecane

Uwaga: Wtyczki niezalecane zwykle nie nadaja sie do codziennej pracy. Wtyczki te nie sg przez nikogo doskenalone ani
aktualizowane. Nie zalecamy ich instalacji, chyba Zze nie ma innej dostepnej alternatywy.

Repozytoria wtyczek

Stan Nazwa URL
@ podigczone Ofigjalne repozytorium wiyczek QGIS https://plugins.qgis.org/plugins/pluginsxmi?qgis=3.4

\Wezytaj ponownie zawartosé repozytorium Edytuj... Usuri
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Mozna tutaj zdefiniowa¢ czy QGIS ma automatycznie szuka¢ aktualizacji do wtyczek
oraz czy na liscie majg by¢ widoczne wtyczki oznaczone jako eksperymentalne. Ponadto
mozna dodawaé wiasne repozytoria wtyczek, klikajac przycisk ,Dodaj...” i definiujac adres
URL do nowego repozytorium.

Jezeli juz zainstalowano wtyczke to w kazdej chwili mozna jg dezaktywowac lub
aktywowaé poprzez zaznaczenie lub odznaczenie pola znajdujgcego sie w linii z
zainstalowang wtyczka.

Zazwyczaj w instalatorze znajduje sie krotka informacja na temat tego jak dziata
wtyczka. Dodatkowo niekiedy autorzy publikujg instrukcje do wtyczek na swoich stronach
internetowych, lub dotaczajg pomoc w paczce z wtyczka.

Lista przydatnych wtyczek

QuickMapServies

Wtyczka, ktéra umozliwia dodawanie i prace z warstwami bazowymi (podktadami)
pochodzacymi z roznych Zzrodet i serwiséw internetowych (np. Google, OSM, Bing).
Obejmuje stale aktualizowang liste ustug, ktére mozna dodac do projektu, za pomocg listy
najpopularniejszych warstw, lub poprzez wyszukiwarke QMS. Umozliwia skalowanie mapy
na wszystkich dostepnych w podkfadzie zoomach.

GeoCoding

Umozliwia wyszukiwanie adresow w QGIS korzystajgc z bazy Google Maps.
Wtyczke instaluje sie przez “Zarzadzanie wtyczkami’. Po instalacji w pasku menu

przybedzie nowa ikona wywotujgca funkcje geokodowania wtyczki

Dostep do ustawien oraz innych funkcji uzyskamy przez poprzez ,Wtyczki’ >
GeoCoding”.

Funkcje ,GeoCoding” wywotuje sie poprzez klikniecie dodanej przez instalator ikony,
badz klikajac menu ,Wtyczki” > “GeoCoding” > “GeoCoding”. W nowo otwartym oknie
nalezy wpisa¢ adres, ktérego lokalizacjia ma zostaé wskazana, w formacie znanym z
wyszukiwarki adreséw Google Maps.

T

Address
Lublin, Lwowska 45|

Gdy QGIS wyszuka kilka adreséw odpowiadajacych lokalizacji, w nastepnym kroku
wyswietli liste adresow, z ktérej nalezy wybraé ten najbardziej pasujacy do wyszukiwania.

Po jego zatwierdzeniu do projektu dodania zostanie warstwa punktowa z lokalizacjg
adresu. Nazwa dodanej warstwy to ,GeoCoding Plugin Results”.

Baza WMS

Dostepna poprzez repozytorium GIS Support: http://qqgis.gis-support.pl/plugins.xml
Wtyczka umozliwia wczytanie danych WMS do projektu QGIS z predefiniowanej listy, ktérg
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W celu pobrania wtyczki i poprawnego jej uzycia:

1. Dodaj repozytorium GIS Support do QGIS

2. Uruchom wtyczke

3. Jesli jeszcze nie masz — wygeneruj prywatny klucz GIS Support. Otrzymasz go we
wiadomosci e-mail, ktéra przyjdzie na podany adres.

4. Jedli posiadasz klucz nie musisz generowa¢ klucza ponownie. Wtyczka sama
znajdzie klucz w ustawieniach QGIS.

5. Jesli klucz nie wczytat sie sam — wprowadz klucz GIS Support w odpowiednie pole
(te czynnosc¢ nalezy wykonac¢ jednorazowo, klucz zostanie zapamietany).

6. Wtyczka jest gotowa do uzycia.

Kluecz GIS Support:

ODQ3MA.MmYA9d3

Nie masz klucza? Zapisz
Zrédto:

Krajowy Zarzad Gospodarki wodnej
Opis:

Adres:
Mapa Podziatu Hydrograficznego Polski 2010
Opis:

Warstwy:

Nazwa warstwy Abstrakt
Zlewnie elementarne Zlewnie elementarne
Zlewnie poziomu 8 Zlewnie poziomu 8
Zlewnie poziomu 6 Zlewnie poziomu 6
Zlewnie poziomu 4 Zlewnie poziomu 4

Zlewnie poziomu 3 Zlewnie poziomu 3

~[o[u[a[w][n]-

Zlewnie poziomu 1 Zlewnie poziomu 1

Granice Panstw Granice Panstw

| Dodaj do mapy |

Instrukcja uzycia:
1. Z listy dostepnych Zzrédet wybierz interesujaca instytucje, badz portal. ktory
udostepnia WMS

2. Z listy adresow wybierz pozgdany adres (czasem jedna instytucja ma kilka adreséw
WMS)

3. Z listy dostepnych warstw wybierz te, ktérg chcesz wczytaé do projektu (mozna
zaznaczy¢ kilka warstw).
4. Kiiknij dodaj do mapy

autoSaver

Wtyczka zapewnia podstawowg funkcje autozapisu dla pliku projektu i

zmodyfikowanych warstw w trybie edycji. Zmiany mozna zapisywaé¢ co okreslony interwat
czasu wyrazony w minutach.



(

4%

21S
>y L

support

)

Cwiczenie 2. Dodawanie danych

Wektor

Dodawanie danych wektorowych odbywa sie poprzez przycisk “Otwérz okno

zarzadzania zrodiami danych’ {‘! i wybor zaktadki “Wektor” w oknie dialogowym.
Nastepnie nalezy wskazac¢ “Typ zrédta danych”, kodowanie pliku oraz lokalizacje warstwy
wektorowej z dysku komputera. Warstwa wczyta sie do projektu po kliknieciu na przycisk
“‘Dodaj”.

(2} Zarzadzanie Zrédtami danych | Wektor ﬁ

. Przegladarka Typ Zrédta danych

(@) Plik () Katalog () Baza danych (_) Dane online: HTTP(S), chmura, etc.

s Raster Kodowanie [UTF—B ']

:A!; Mesh Zrodto
s sy Dane wektorowe 1esktop\Ministerstwo\Dane_podstawy_QGIS\Cwiczenia\2\wojewddztwa.shp €1 E]

Sﬁ GeoPackage

i’; Spatialite

PostgreSQL

MSSQL

*
L]
*

Oracle

082, DB2

m Warstwa wirtualna
&3 wmspwms

& wes

WEFS

*

#7 ArcGIS Map Server zomknij | [ Dodaj | [ Pomoc

Raster
Dodawanie danych rastrowych odbywa sie poprzez przycisk “Otwérz okno
zarzadzania zrédtami danych’ ‘! i wybor zaktadki “Raster” w oknie dialogowym.

Nastepnie nalezy wskaza¢ “Typ zrédta danych” oraz lokalizacje warstwy rastrowej z dysku
komputera. Warstwa wczyta sie do projektu po kliknieciu na przycisk “Doda;j”.
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(@ Zarzadzanie #rodtami danych | Raster

W Przegladarka Typ #rédta danych
- g Wektor @ Plik (©) Dane online: HTTP(S), chmura, etc.

Erodio
:"‘L Mesh Dane rastrowe sort\Desktop\Ministerstwo\Dane_podstavy_QGIS\Cwiczenia\2\studium_ref.tf & [...]
- C5V

{54 GeoPackage

7, Spatialite
» PostoresQL
s MSSQL
' Oracle
082, pB2
Wi Warstwa wirtuaina
&3 wvs/wmrs
& wes

» WS

'2',;3 ArcGIS Map Server zamkny | [ voday | [ pomoc

Dane tabelaryczne

Tabele nieprzestrzenne
Dodawanie tabel nieprzestrzennych odbywa sie analogicznie do warstw wektorowych
(patrz wyzej).

Tabele przestrzenne
Dodawanie tabel przestrzennych odbywa sie poprzez przycisk “Otwérz okno

zarzadzania zrédtami danych” ‘! i wybor zaktadki “CSV” w oknie dialogowym.
Nastepnie nalezy wskaza¢ “Nazwe pliku” (lokalizacje) i wybra¢ kodowanie pliku. Nizej
nalezy wskazaé¢ format pliku (w zaleznosci od separatora jakim rozdzielone sg kolumny w
tabeli) oraz ustawienia geometrii. W tym miejscu wskazuje sie kolumny, ktére przechowujg
wspotrzedne XY (w przypadku punktdw) lub wspétrzedne WKT (w przypadku linii i
poligonéw) oraz dokonuje wyboru ukfadu wspotrzednych w jakim sg zapisane koordynaty.
Po zdefiniowaniu wszystkich elementéw nalezy klikng¢ przycisk “Dodaj”, ktéry spowoduje
wczytanie warstwy do projektu.

==

| Nazwa pliku sers\GIS Support\Desktop\Ministerstwo\Dane_podstawy_QGIS\Cwiczenia\2\przejscia_graniczne.csv & [, |

() Zarzadzanie zr6dtami danych | CSV!

b Przegladarka

s MSSQL

4 Oracle

£ wes

& WES

9’ ArcGIS Map Server

(7) format WKT (Well Known Text)
(7)) Bez geometril (tylko tabela atrybutdw)

Ukiad wspdtrzednych

* Wekior Nazwa Warstwy przejscia_graniczne
%, Raster v Format pliku I
2% Mesh () csV (rozdzielone przecinkami) [ Tap [ Dwukropek ] spacia
M3 Mes - !
(©) wyrazenie regularne Srednik [ Przecinek Tnne
(@) Rozdzielone innym znakiem ~ OPakowanie Zakideen |~
-‘1& GeoPackage
2 b Opcje wierszy i kolumn
g il v Ustawienia geometri
« PoStoresQL (@ wspdirzedne punktowe X [x -

Y [y

[7] wspétrzedne SMS

[Ukdad wspdtregdnych projektu: EPSG:4326 - WGS 84

- @

De2 2
D52 b Ustawienia warstwy
['4 ‘Warstwa wirtualna Przyktadowe dane
&2 wvspwmts id name type dassi S

1 15610 Przejicie graniczne Hrubieszow-Wiodzimierz Wolyriski border_control barrier =

4| 1

»

[ zamknj | [ Dodaj

j

10
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Cwiczenie 3. Symbolizacja danych i etykietowanie

Symbolizacja warstw wektorowych

Aby zmieni¢ symbolizacje warstwy wektorowej nalezy wejs¢ w jej wiasciwosci
poprzez klikniecie prawym przyciskiem myszy na nazwe warstwy w panelu warstw i wybér
pozycji “Wlasciwosci’, lub poprzez dwukrotne klikniecie lewym przyciskiem myszy na
nazwie warstwy. W oknie dialogowym nalezy przejS¢ na zaktadke “Styl”. W pierwszej
kolejnosci nalezy wybraé rodzaj symbolizacji.

QGIS ma kilka typédw symbolizacji danych przestrzennych, gtéwnie z nich to:

Symbol pojedynczy - symbolizacja obejmujgca wszystkie obiekty warstwy;

Wartos¢ unikalna - klasyfikuje obiekty wg unikalnej wartosci z tabeli atrybutéw lub

wyrazenia;

e Symbol stopniowy - klasyfikuje obiekty w przedziatach wartosci z tabeli atrybutow
lub wyrazenia;

e Oparta na regutach - pozwala zdefiniowa¢ dowolne reguty na podstawie wartosci z
tabeli atrybutéw Ilub wyrazenia, jest to rozwiniecie dwdch poprzednich typdw
symbolizacji.

e ey ===

= Jeden symbol

{

22
238

LEs
CE1

o oW

R a0y mooign

Ny Widok 3D )

[
il8 ro.
Krycie [] 100,0 %

Formularz Kolor
==l atrybutow [l

|

gradient plasma gray 3 fill hashed black / hashed black \ hashed black X outline blue outline green outline red
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Symbol pojedynczy

Standardowy typ symbolizacji obejmujacy wszystkie obiekty warstwy bez
wykorzystania tabeli atrybutéw. Okno dostepne w tym trybie jest standardowe réwniez dla
pozostatych typow stylizacji podczas definiowania symbolu. Skfada sie ono z trzech
gtébwnych czesci. W goérnej lewej stronie znajduje sie podglad symbolu, ponizej sag
poszczegdblne warstwy symbolu (symbol moze sktada¢ sie z wielu warstw) wraz z
przyciskami do zarzadzania, a z prawej strony szczegdtowe ustawienia dla tych warstw. W
zaleznosci od typu geometrii jest dostep do réznych rodzajow symboli. Warstwy moga by¢
zagniezdzone np. stylizacje centroidow poligondw dokonuje sie na warstwie znacznikéw i
dostepne sg opcje takie same jak przy stylizacji warstwy punktowe;.
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Zdefiniowane symbole mozna zapisa¢ i wykorzystaé w innych warstwach lub
projektach. W menu “Ustawienia’ > “Zarzadzanie stylem” mozna zarzadza¢ dostepnymi
symbolami dla poszczegdlnych typoéw geometrii oraz paletg kolorow.
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Wartos¢ unikalna

Stuzy do oznaczania unikalnych kategorii obiektéw na podstawie informacji
atrybutowych (typ, rok itp..). Z pola wyboru “Kolumna” nalezy wybraé¢ kolumne, dla ktorej
zostang pobrane wartosci unikalne. Mozna réwniez wykorzysta¢ kreator wyrazen do
zdefiniowania bardziej skomplikowanych warunkéw symbolizacji. Nad listg mozna wybrac
interesujgca nas palete koloréw - istnieje rowniez mozliwo$¢ dodania wtasnych palet.

Po kliknieciu przycisku “Klasyfikuj” na liscie pojawig sie symbole dla poszczegdlnych
unikalnych wartosci. Klikajac podwojnie na symbol mozna dodatkowo zmieni¢ domys$iny
przypisany styl dla grupy. W kolumnie “Legenda” mozna zmieni¢ opisy poszczegoélnych
grup.

Definiowanie poszczegdlnych symboli
pojedynczego.
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Symbol stopniowy

Dziata podobnie jak “Wartos¢ unikalna”, ale stuzy do klasyfikacji wartosci ciggtych i
wyswietlaniu ich w konkretnej klasie na podstawie wyliczonych przedziatéw. Wynikiem jest
kartogram. Poza wybraniem kolumny i palety koloréw nalezy okresli¢ sposéb w jaki QGIS
wyliczy przedziaty oraz liczbe klas. Wsréd trybow dokonania podziatu znajdujg sie
statystyczne (Réwne podziaty, Kwantyle, Odchylenie standardowe) oraz specjalne algorytmy
do wyznaczania granic w sposob bardziej naturalny (Naturalny podziat, tadny podziat).

Po automatycznym wyznaczeniu przedziatdw mozna je dostosowac na dwa sposoby:
recznie zmieniajgc zakresy w kolumnie Wartosci oraz za pomocg histogramu. W tym drugim
przypadku nalezy przejs¢ na zaktadke Histogram i klikng¢ przycisk “Wczytaj wartosci”.
Pojawig sie granice zakresow, ktére mozna przesuwac¢ za pomocg kursora. Definiowanie
poszczegoélnych symboli odbywa sie analogicznie jak dla symbolu pojedynczego.
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Symbolizacja oparta na regutach

Ten typ symbolizacji daje najwiekszg kontrole nad wygladem warstwy. Pozwala on
zdefiniowaé reguty, ktére pozwalajg grupowacC obiekty na podstawie réznych, nawet
niezaleznych od siebie kryteriow (np. jednoczesna symbolizacja w oparciu o powierzchnie i
liczbe ludnoséci danego obszaru).

Poszczegdlne reguty sprawdzane sg od géry do dotu, tak wiec symbole regut z
poczatku listy znajdg sie ponizej symboli regut z dolnej czesci listy (zostang przez nie
zakryte). Jesli jednak chcemy ustawi¢ kolejnos¢ wyswietlania niezaleznie od kolejnosci regut
mozna klikng¢ przycisk “Kolejno$¢é wyswietlania” i recznie ustawic¢ ich priorytet.

Reguty mozna =zagniezdza¢ jedna w drugiej. W takim przypadku najpierw
sprawdzana jest reguta znajdujgca sie najwyzej w strukturze, jesli nie jest ona spetniona to
jej pochodne nie sg sprawdzane.

Ustawienie wartosci filtra na ELSE pozwala zdefiniowac¢ symbol obiektéw, dla ktdrych
nie zadna regufa nie zostata spetniona.

Definiowanie poszczegdlnych symboli odbywa sie analogicznie jak dla symbolu
pojedynczego.
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Typy warstw symbolu

W zaleznosci od rodzaju geometrii dostepne sg rézne typy warstw symbolu
posiadajace rézne opcje konfiguracyjne.
Punkt
e Prosty znacznik - mozliwy jest wybor ksztattu znacznika z kilku dostepnych oraz
takie wiasciwosci jak kolor wypetnienia i obrysu, rozmiar symbolu, przesuniecie, kat
obrotu;
e Elipsa - podobne do prostego znacznika, ale umozliwia niezalezne ustawienie
wysokosci i szerokosci znacznika;
e Znacznik z czcionki - pozwala ustawi¢ jako symbol dowolny znak z dostepnych w
systemie czcionek
e Znacznik SVG - ustawienie jako symbolu grafiki w formacie SVG. Dostepna jest
bogata biblioteka dostarczonych z QGIS plikbw SVG i podzielonych na kilka
kategorii. Mozna réwniez wykorzystaé wtasne pliki SVG stworzone w aplikacjach
takich jak Inkscape czy Corel Draw.
Linia
e Zwykla linia - standardowa linia z mozliwoscig ustawienia koloru, szerokosci, stylu
linii (linia, kropki, kreski), jej potaczen i zakonczen
e Linia ze znacznikéw - pozwala umiesci¢é na linii znaczniki. Znaczniki sg
symbolizowane w ten sam sposéb jak punkty. Rozmieszczenie znacznikéw na linii
mozna zdefiniowa¢ na jeden ze sposobow:
o rowne odstepy, ktére mozna zdefiniowa¢ w mm lub jednostkach mapy,
o na kazdym wierzchotku linii,
o na ostatnim albo pierwszym wierzchotku linii,
o w punkcie $rodkowym linii
e Strzatka - wskazuje kierunek i zwrot danego obiektu wektorowego
Poligon (wypetnienie)
e Proste wypetnienie - standardowy styl dla poligonéw pozwalajgcy ustawié¢ kolor i
styl wypetnienia/obrysu czy szeroko$¢ obrysu,
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Wypetnienie: centroid - symbol wyswietlany jest w punkcie centralnym poligonu,
stylizacja taka sama jak przy znacznikach,

e Wypetnienie: gradient - ustawienie wypetnienia jako gradient, ktéry mozna
zdefiniowaé z dwoch koloréw (poczatkowy i koncowy) lub palety kolorow

e Wypetnienie: gradient ksztaltu - podobne do zwyktego gradientu, ale kierunek
rozchodzenia sie koloréw uzalezniony jest od ksztattu poligonu i odzwierciedla jego
ksztatt

e Wypetnienie: linie - umozliwia wypetnienie poligonéw rownolegtymi liniami
ustawionymi pod zadanym katem i w danej odlegtosci, linie mozna stylizowac¢ tak
samo jak warstwy liniowe,

e Wypetnienie: znaczniki - podobne do wypetnienia centroidem, ale znaczniki sg
réGwnomiernie rozmieszczone na siatce o zadanej szerokos$ci i wysokosci,
Wypetlnienie rastrem - pozwala wypetni¢ poligon plikiem graficznym,

Wypetnienie SVG - podobne do wypetnienia rastrem, ale za pomoca plikéw SVG i z
mozliwoscig zmiany kolorow,

e Obrys: linia ze znacznikéw - obrys poligonu mozna stylizowa¢ w ten sam sposéb
jak linie ze znacznikéw dla warstw liniowych,

e Obrys: zwykla linia - obrys poligonu mozna stylizowac¢ w ten sam sposéb jak zwykig
linie dla warstw liniowych.

QGIS posiada wtasny format zapisu zdefiniowanych styléw do pliku w formacie QML.
W celu zapisania stylu nalezy z menu przycisku “Styl” (dolna lewa cze$¢ zaktadki “Styl”) i
wybra¢ z podmenu “Zapisz styl” opcje “Plik stylu warstwy QGIS”. Utworzony plik moze
zosta¢ przestany innym uzytkownikom lub wczytany w innym projekcie dla tej samej
warstwy. Jesli plik QML umieszczony zostanie w tym samym folderze co plik z danymi
przestrzennymi i z takg samg nazwa to po zatadowaniu warstwy do QGIS stylizacja z tego
pliku zostanie automatycznie wczytana. Nalezy jednak pamietac¢, ze jesli symbolizacja
korzysta z zewnetrznych danych (np. plik SVG) moga wystgpi¢ problemy przy jej
przenoszeniu pomiedzy lokalizacjami.

Klikajac prawym przyciskiem myszy na warstwe i wskazujgc podmenu “Styl” mozna
kopiowac i wkleja¢ style pomiedzy wczytanymi warstwami.

Etykietowanie warstw wektorowych

Opcje zwigzane z etykietowaniem warstwy wektorowej znajdujg sie w jej
wiasciwosciach, na zaktadce “Etykiety”. Aby wigczy¢ etykietowanie, w gérnej czesci okna
nalezy z listy rozwijanej wybra¢ opcje “Proste etykiety” - uaktywni to mozliwosé zarzgdzania
etykietami. W polu “Etykietuj z’ nalezy wskaza¢ kolumne, z ktérej ma wyswietla¢ sie tekst,
mozna rowniez wykorzysta¢ kreator wyrazen aby stworzy¢ etykiety ztozone.

Gtowng czes¢ okna zajmujg opcje zwigzane z ustawieniami etykiet. Na zaktadce
“Tekst” mozna zmieni¢ m.in. czcionke i kolor tekstu oraz odstepy pomiedzy wyrazami i
znakami. Kolejna zaktadka “Formatowanie” stuzy do zmiany interlinii pomiedzy wierszami
(dla etykiet wielowierszowych), wyréwnania tekstu i formatowania liczb. “Otoczka” stuzy do
dodania efektu halo wokot wysSwietlanego tekstu. Zwieksza to czytelnos¢ etykiet
wyswietlanych na mapie. Na zaktadce “Tto" mozna wstawi¢ ksztatt lub grafike SVG, ktéra
bedzie ttem dla tekstu, a “Cien” stuzy do dodania dodatkowego efektu cieniowania tekstu
(oraz innych elementow jesli tworzg etykiete).
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Zakfadka “Potozenie” jest inna w zaleznosci od rodzaju geometrii danej warstwy.

Wspodlne sa grupy “Oparte na danych” i “Priorytet’. Pierwsza grupa pozwala okresli¢
potozenie etykiety poprzez wskazanie wspoétrzednych na mapie oraz jej wyréwnania i
nachylenia z tabeli atrybutéw lub wyrazenia. Jesli te opcje sgq uzyte to nadpisujg inne opcje
zwigzane z potozeniem. “Priorytet” wskazuje pierwszehstwo rysowania etykiet danej
warstwy nad etykietami innych warstw. Opcje w grupie “Potozenie” zalezne sg od typu
geometrii:

Punkty

Linie

wokét punktu - przy zaznaczeniu tej opcji QGIS prébuje automatycznie znalezé
najlepszg pozycje dla etykiety w poblizu punktu zaczynajgc od strony gérnej-prawej
do dolnej-lewej. Uzytkownik moze dodatkowo wskazac odsuniecie tekstu od punktu
(w mm lub jednostkach mapy);

odsuniecie - pozwala wybraé, z ktorej strony od punkty ma znalez¢ sie etykieta, jesli
tekst nie miesci sie na mapie to nie zostanie wyswietlony;

kartograficzne - podobne do opcji wokét punktu, ale z mozliwoscig wiekszej kontroli
przez uzytkownika, automatyczne wyszukiwanie dziata nieco inaczej, wiec efekt jest
odmienny od wczesniejszej opciji.

réwnolegte - tekst jest nachylony zgodnie z linig, ale nie jest zaginany na zakretach,
mozna ustawi¢ czy ma by¢ nad, pod czy na linii oraz w jakiej od niej odlegtosci ma
sie znajdowad;

elastycznie - podobny do opcji rownolegte, ale tekst jest zaginany na zgieciach linii.
Ustawiajac wiekszy maksymalny kat pomiedzy znakami na krzywej mozna zwiekszy¢
liczbe wyswietlanych etykiet jesli linie majg ostre zakrety (np. rzeki);

poziomo - tekst jest zawsze poziomy, nie nachylony wg linii.

Poligony

odsuniecie od centroidu - opcja analogiczna do odsuniecie dla warstwy punktowe;.
Etykieta ustawiana jest wg centroidu poligonu, jesli centroid znajduje sie poza
poligonem mozna wymusi¢, aby punkt etykietowania zostat zmieniony na znajdujacy
sie w jego wnetrzu;

wokot centroidu - opcja analogiczna do wokét punktu dla warstwy punktowej;

z uzyciem brzegu - etykieta zostanie umiejscowiona wzdtuz brzegu poligonu;
poziomo - QGIS postara sie wyszuka¢ optymalnego potozenia etykiety wewnatrz
poligonu, teksty sg ustawione poziomo;

dowolnie - podobne do opcji poziomo, ale teksty moga by¢ ustawione pod katem.
Zaktadka “Renderowanie” pozwala ustawi¢ opcje widocznosci etykiet. Wyswietlanie

etykiet mozna uzalezni¢ od skali mapy oraz min. i max. dtugosci tekstu w pikselach. Mozna
réwniez wymusi¢ wyswietlanie wszystkich etykiet, nawet jesli nachodzg na siebie oraz
osobne etykietowanie kazdej czesci obiektow wieloczesciowych.
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Symbolizacja warstw rastrowych

Aby zmieni¢ symbolizacje warstwy rastrowej nalezy wejs¢ w jej wtasciwosci poprzez
klikniecie prawym przyciskiem myszy na nazwe warstwy w panelu warstw i wybér pozycji
“Wtasciwosci”, lub poprzez dwukrotne klikniecie lewym przyciskiem myszy na nazwie
warstwy. W oknie dialogowym nalezy przejs¢ na zaktadke “Styl”. W pierwszej kolejnosci
nalezy wybra¢ “Sposéb wyswietlania”.

QGIS ma kilka typédw symbolizacji danych przestrzennych, gtéwnie z nich to:

e Jednokanalowy szary - symbolizacja klasyfikujagca wartosci z rastra
jednokanatowego na podstawie skali szarosci;

e Jednokanalowy pseudokolor - symbolizacja klasyfikujgca wartosci z rastra
jednokanatowego na podstawie palety barwnej;

e Cieniowanie - tworzy cieniowany obraz rzezby terenu, wykorzystywany gtownie przy
symbolizacji numerycznych modeli terenu;

e Kolor wielokanatowy - pozwala zdefiniowa¢ wartosci i barwy dla poszczegélnych
kanatow rastra wielokanatowego;

o Paleta/Unikalne wartosci - symbolizacja klasyfikujgca wartosci z wybranego kanatu
rastra wielokanatowego na podstawie palety barwne;j.
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Cwiczenie 4. Uslugi sieciowe i wykorzystanie
otwartych danych

WMS/WFS
Dodawanie danych WMS/WFS odbywa sie poprzez przycisk “Otwérz okno

zarzadzania zrédtami danych” ‘E i wybor zaktadki “WMS/WMTS” lub “WFS” w oknie
dialogowym. Nastepnie nalezy utworzy¢ nowe potaczenie do ustugi sieciowej poprzez
klikniecie przycisku “Nowa”. W nowym oknie nalezy wpisa¢ nazwe tworzonego potgczenia
oraz poda¢ adres URL do ustugi sieciowej (przyktadowe adresy WMS mozna znalez¢ na
stronie geoportal.gov.pl), a nastepnie klikng¢ przycisk “OK”. Po zdefiniowaniu potaczenia
mozna nawigza¢ potaczenie klikajagc na przycisk “Potacz”. Na liscie warstw powinny
wyswietli sie dane, ktére sg udostepniane przez dang ustuge. Aby doda¢ warstwe do
projektu nalezy zaznaczyc jg na liscie i klikng¢ na przycisk “Dodaj”.

Q Data Source Manager | Przegladarka | WMS/WMTS &

B Przegladarka -

Warstwy Kolejnos¢ warstw Kafle Szukaj serwera

. g Wektor
ortofotomapa >

- Raster | Fotacz ‘ HNowa Edytuj Usur Wezytaj Zapisz Dodaj domysine serwery

"
i s Mesh D ~ Nazwa Tytut Streszczenie

v 0 Om:fatcmapy

csv v 1 ORTOFOTOMAPA ORTOFOTOMAPA

L}

l?;& GeoPackage

i"’; Spatialite

- PostgreSQL
Kodowanie obrazu

« MSSQL :
PNG PNGS () JPEG GIF TIFF SVG

 Oracle

Opcje (0 dostepnych ukladé pétrzednych)
B8, pa2
Rozmiar kafla

WA warstwa wirtualna
LE' B Rozmiar kroku zadania (px)
Limit obiektdvs dla GetFeatureInfo 10
Zmien...
Uzywaj kontekstowej legendy WMS
‘ga ArcGIS Map Server
o Nazwa warstwy
&) g ArCGIS Feature Server Wyblerz warstwe(y)
Zamknij Dodaj Pomoc

» GeoMNode

OpenStreetMap

QuickOSM

Oprocz wczytywania rastrowych podktadéw do QGIS za pomocg wtyczki QMS,
istnieje réwniez mozliwos¢ pobierania danych z OSM w formie wektorowej. Stuzy do tego
wtyczka Quick OSM. Po jej zainstalowaniu i uruchomieniu z paska narzedzi otwiera sie
okno, w ktérym mozna zdefiniowa¢ zapytanie do bazy OSM, za pomocg ktérego uzyskuje
sie interesujgce dane wektorowe.
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QuickOsM

I‘E'j. Quick query

| Help with key/value | Zresetuj

* My queries Key  admin_level v
' Query Value -
[ osmFile
e @® Extent of the map canvas
% P t -
 Parameters Extent of a layer
w Advanced
Node ©& Points &
Way = Lines &
Relation & Multilinestrings &
Multipolygons &
Timeout |25
Directory |Save to temporary file Browse

File prefix

Show query Run query

W pierwszej kolejnosci nalezy wybrac klucz oraz wartosc¢ dla warstwy, z ktorej maja
zosta¢ pozyskane dane — wiecej o kluczach i wartosciach mozna znalez¢ na stronie
http://wiki.openstreetmap.org/wiki/Map_Features lub za pomocg przycisku ,Help with
keyl/value”. Po ich wybraniu okresli¢ nalezy obszar, z ktérego pochodzi¢ majg dane. Do tego
celu stuzg 3 opcje:

e okreslenie konkretnego obszaru poprzez wpisanie wartosci z jego nazwg (miasto,
gmina itd.)

wybér obiektow do zasiegu mapy

wybér obiektow do zasiegu warstwy

Dodatkowo okresli¢ mozna opcje zaawansowane czyli wybér typow obiektéw, czas
wykonywania zapytania przez serwer oraz wskaza¢ folder, w ktérym majg zapisac sie
pobrane warstwy (w innym przypadku warstwy dodane zostang do otwartego projektu QGIS
i bedg traktowane jako warstwy tymczasowe). Po zdefiniowaniu zapytania nalezy klikng¢
przycisk ,Run query”, ktory przesle zapytanie do bazy OSM i po uptywie okreslonego czasu
doda pozgdane warstwy do okna mapy.

Przyktadowo, aby pobra¢ dane dotyczace lokalizacji bankomatéw w Lublinie nalezy
wybra¢ odpowiedni klucz oraz wartos¢ dla danej warstwy — w tym przypadku bedzie to
kolejno ,amenity” i ,atm”. Nastepnie okresli¢ lokalizacje korzystajac z pierwszej opcji,
wpisujgc w pole tekstowe nazwe miasta — Lublin, natomiast w ustawieniach
zaawansowanych zwiekszy¢ czas zapytania do wartosci 250. Po zdefiniowaniu powyzszych
pol uruchamiamy zapytanie przyciskiem ,Run query”, ktére po kilkunastu sekundach
powinno zwroci¢ wynikowg warstwe punktowg z lokalizacjg bankomatow na terenie Lublina.
Od teraz mamy mozliwo$¢ petnej edyciji i zarzgdzania powyzszymi danymi z poziomu QGIS.
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Cwiczenie 5. Tworzenie nowych danych i edycja

Tworzenie warstw

W menu “Warstwa” > “Twoérz warstwe” nalezy wybraé opcje Twérz nowg warstwe

Shapefile... lub przycisk V" na pasku narzedzi. Nastepnie w oknie dialogowym nalezy
podac¢ nazwe (lokalizacje) pliku, kodowanie pliku, typ geometrii, oraz uktad wspotrzednych
warstwy. W czesci “Nowe pole” mozna dodac nowe atrybuty do warstwy. W tym celu nalezy
podac¢ nazwe kolumny, wybraé typ oraz zdefiniowaé dtugosé/doktadnosc¢ i nastepnie klikngé
przycisk “Dodaj do listy pol”.

Dtugos¢ wskazuje ile maksymalnie znakoéw moze zawieraé¢ dane pole. Dla tekstu
domys$inie ustawiona jest wartos¢ 80 znakow - dtuzsze teksty zostang obciete. Max. warto$¢
dla plikow Shapefile mozliwa do ustawienia to 255. Podobnie wyglada to dla liczb
catkowitych. Dla liczb dziesietnych poza szerokoscig nalezy ustawi¢ doktadnos¢, czyli liczbe
cyfr, ktére mozna wstawi¢ po przecinku. Ustawienie szerokosci na 6, a dokladnosci na 3
pozwala zapisa¢ liczby do wartosci 999,999.

Po kliknieciu “OK” QGIS automatycznie stworzy wszystkie wymagane pliki (shp, sbf i
shx) oraz pliki z informacjg o uktadzie wspotrzednych (prj i gpj).

{: Nowa warstwa Shapefile

Nazwa pliku

Kodoweanie pliku [utrs -

]
Typ geometrii [ Punke vJ

Zawriera wysokoSé (Z) [7] zawiera miare (M)

‘EPSG‘.ZIEU - ETRS89 / Poland €592

Nowe pole

Nazwa

Typ abe Dane tekstowe ~ ‘

Dlugosé 80 Doktadnodé

Lista pél

Nazwa Typ Dlugo&é Dokladnoéé
id Integer 10

Tworzenie obiektow
Aby mie¢ mozliwos¢ tworzenia obiektdow na warstwie wektorowej nalezy wtaczy¢ “Tryb

edycji” 7oz poziomu paska narzedzi. Po jego kliknieciu dana warstwa przechodzi w tryb
edyciji, a poszczegolne przyciski do edycji sg aktywowane. W zalezno$ci od typu geometrii mogg
by¢ dostepne rézne opcje rysowania. Dziatanie przyciskow odnosi sie do warstwy aktualnie
zaznaczonej na liscie (aktywnej).
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Dodanie nowego obiektu odbywa sie za pomocag przyciskow uzaleznionych od typu

ee 3 )
geometrii, ktére moga przyjmowac nastepujgca postac: © 3, o lub . Po wybraniu tej opciji

lewym klawiszem myszy na oknie mapy mozna narysowacC geometrie obiektu wektorowego. W
przypadku ztozonych geometrii (linie, poligony), aby zakonczy¢ tworzenie geometrii nalezy
klikng¢ prawy przycisk myszy (miejsce tego klikniecia nie jest dodawane do geometrii). Po
dodaniu geometrii pojawi sie formularz do wprowadzenia wartosci atrybutéw obiektu.

&

Aby zapisa¢ zmiany w warstwie nalezy kliknaé na przycisk “Zapisz edycje” na

pasku narzedzi.

Aby wyjs¢ z trybu edycji nalezy ponownie klikna¢ na przycisk "Tryb edycji” ¥ na pasku
narzedzi.

Edycja warstw

Jesli QGIS umozliwia edycje warstwy w danym formacie na pasku narzedzi aktywny jest

przycisk “Tryb edycji” ¥ . Po jego kliknieciu dana warstwa przechodzi w tryb edycji, a
poszczegolne przyciski do edycji sg aktywowane. W zaleznosci od typu geometrii mogg by¢
dostepne rézne opcje edycji. Dziatanie przyciskéw odnosi sie do warstwy aktualnie zaznaczonej
na liscie, szczegolnie wazne jesli edytowanych jest kilka warstw jednoczesnie. Aby wyjs¢ z trybu

edycji nalezy ponownie klikng¢ na przycisk #

Podstawowe narzedzia edycji

e Przesun obiekt(y) (% - pozwala przesuwac geometrie za pomocg lewego klawisza
myszy. Jesli zaznaczono kilka obiektow to bedg przesuwane wszystkie jednoczesnie.

e Edycja wierzchotkow 0‘7_& - pozwala edytowac ksztatt geometrii. Po najechaniu na
obiekt wszystkie jego wierzchotki zaznaczone sg na czerwono. Klikniecie w wierzchotek
zaznacza go na niebiesko - mozna zmieni¢ jego potozenie lewym klawiszem myszy za
pomoca metody klik-klik. Podobnie jak pojedynczy wierzchotek mozna przesuwac
pojedyncze segmenty linii. W momencie klikniecia na segment linii zostang zaznaczone
dwa wierzchotki tworzace ten odcinek - mozna go teraz przesuwac klikajac na miejsce
docelowe, na ktére ma zostaC przeniesiony. Aby doda¢ nowy wierzchotek nalezy

najechac¢ na srodek segmentu i klikng¢ na pojawiajacy sie na nim czerwony znak plus.
=5

e Usun zaznaczone [ - usuwa zaznaczone obiekty z danej warstwy.

=

e Kopiowanie i wklejanie obiektéw - za pomocag tych narzedzi mozna
skopiowa¢ zaznaczone obiekty. Skopiowane obiekty mozna wklei¢ do tej lub innej
warstwy (musi by¢ w trybie edycji). W tym drugim przypadku atrybuty pomiedzy
warstwami zostang dopasowane na podstawie nazw pol. Jesli warstwy majg rézny typ
geometrii QGIS sprébuje przeprowadzi¢ konwersje, jesli sie nie powiedzie obiekty nie
zostang dodane. Skopiowane obiekty mozna réwniez zapisa¢ do nowej warstwy w menu
“‘Edycja” > “Wklej obiekty jako...” > “Nowa warstwa wektorowa”. Pojawi sie okno do
zapisu danych.
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(= Zapisz warstwe wektorowg jako... G

Format ESRI Shapefile g
Nazwa pliku
Nazwa warstwy

Uktad wspdfrzednych | EPSG:2180 - ETRS89 [ Poland €592 b

Kodowanie UTF-8 b
Zapisz tylko zaznaczone obiekty
v/ Dodaj zapisany plik do mapy
w Wybierz pola do eksportu i opcje eksportu
Nazwa Typ
v id Integertd

V| Data String

V| Gmina String

OK Anuluj Pomoc

Nalezy w nim zdefiniowa¢ format dla nowej warstwy, wskaza¢ nazwe (lokalizacje
pliku) oraz okresli¢ docelowy uktad wspodtrzednych. Opcjonalnie mozna ustawi¢ kodowanie i
wybrac¢ pola do eksportu. Cato$¢ nalezy potwierdzi¢ przyciskiem “OK”.

Przyciaganie (snapping)

Przycigganie utatwia tworzenie i edytowanie obiektow z wykorzystaniem istniejgcych
geometrii. Tolerancje przyciggania pozwala okresli¢ promien w jakim QGIS bedzie wyszukiwat
najblizszego istniejgcego wierzchotka lub segmentu.

Opcje przyciggania mozna ustawi¢ w pasku przyciggania wtgczajgc go poprzez menu “Widok” >
“Paski narzedzi” > “Przyciaganie”.

Dostepne sa trzy tryby przyciggania:

aktywna warstwa - ustawienia przyciggania dotycza aktualnie zaznaczonej warstwy,

wszystkie warstwy - przycigganie dotyczy wszystkich wczytanych warstw,

zaawansowane - pozwalajg ustawi¢ poszczegdlne opcje dla kazdej warstwy
indywidualnie.

Jednoczesnie mozna przycigga¢ do wierzchotka, segmentu lub obu tych elementow.
Dodatkowo mozna zaznaczy¢ opcje “Wlacz przycigganie na przecieciach”, aby mie¢ pewnosc¢,
ze nawet jesli na przecieciu segmentow nie ma wierzchotkdw to kursor i tak zostanie
przyciggniety. Tolerancje mozna okresli¢ jako liczong na podstawie jednostki miary dla dane;j
warstwy (zaleznej od uktadu wspotrzednych; odlegtos¢ przyciggania zalezy od skali mapy) lub w
pikselach (stata, niezaleznie od skali).

Jesli witaczone jest przyciaganie, QGIS wyswietli fioletowy kwadrat w miejscu, do ktérego
zostanie dociggniety kursor w momencie klikniecia.
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Dodawanie punktu na podstawie wspoétrzednych

Dodawanie punktéw na bazie wspétrzednych umozliwia wtyczka LatLon Tools 1]
dostepna poprzez zarzadzanie wtyczkami. Po jej zainstalowaniu narzedzia wtyczki bedag

T, I B () XY
E: ’ L{» u\a ok E . Aby dodac¢ punkt na

dostepne z poziomu paska narzedzi =)
bazie wspétrzednych nalezy witagczy¢ tryb edycji warstwy punktowej a nastepnie z narzedzi

wtyczki wybraé przycisk “Lat Lon Digitize” ““* . W nowym oknie dialogowym nalezy

Y [~ XY+
wprowadzi¢ wspotrzedne punktu. W oknie za pomocg przyciskow ' mozna
wybra¢ uktad wspotrzednych wiasciwy dla wprowadzanych koordynatow oraz okresli¢
kolejnos¢ wspdtrzednych X i Y. Po kliknieciu na przycisk “Add Feature” punkt zostanie
dodany do warstwy w lokalizacji zgodnej z wprowadzonymi wspotrzednym.

(.} Add Feature o
Enter Coordinate Y |~ XY~
Input Projection: Wgs84 - Coordinate Order: Lon, Lat

Add Feature Exit
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Cwiczenie 6. Praca z tabelg atrybutow

Edycja
Na pasku narzedzi tabeli atrybutéw pierwsze narzedzia stuzg do edycji danych: “Tryb
edycji” J , “Zapisz edycje” B oraz “Usun zaznaczone rekordy” [ . Aby zmienié

warto$¢ atrybutu nalezy wiaczy¢ tryb edycji oraz wybra¢ komérke do zmiany wartosci. Po
wprowadzeniu nowej wartosci mozna zapisa¢ zmiany na warstwie.

G gminy : Liczba obieki6w: 196, odfiltrowanych: 196, zaznaczonych: 0 =5 [

2B B5<s @ & CYTELPD REES 26

[abeammakop )= (€] - Aktualizy) zaznaczone
GMINA_KOD WOJ_KOD POW_KOD woJ POWIAT =

1 i0507052 06 0607 lubelskie krasnicki || E ‘

2 0603082 06 0603 lubelskie chetmski |7

3 0601162 06 0601 lubelskie bialski

4 0619062 06 0619 lubelskie wiodawski \

5 0607042 06 0607 lubelskie krasnicki «

6 0607062 06 0607 lubelskie krasnicki

7 0607072 06 0607 lubelskie krasnicki

8 0607082 06 0607 lubelskie kranicki 1

9 0607092 06 0607 lubelskie krasnicki \

10 0607102 06 0607 lubelskie krasnicki

11 0608022 06 0608 lubelskie lubartowski

12 0608032 06 0608 lubelskie lubartowski I

13 0606042 06 0606 lubelskie krasnostawski 1

14 0606062 06 0606 lubelskie krasnostawski I

15 0606072 06 0606 lubelskie krasnostawski 1

16 0606082 06 0606 lubelskie krasnostawski I

< | [ ] r

T Pokez wszystiie obiekty,| BE

Selekcja

QGIS udostepnia narzedzia do zaznaczania danych wektorowych. Sg one dostepne
w pasku narzedzi pod nastepujgcymi ikonami: “Zaznacz obiekty prostokatem lub

kliknieciem” E{\\* , “Zaznacz obiekty wyrazeniem” ﬁ"'] , “Usun zaznaczenie obiektéw
ze wszystkich warstw” q’-fj .
Selekcja wzgledem atrybutéw

Wywotuje sie za pomocg przycisku “Zaznacz obiekty wyrazeniem” % . Pozwala

na zaznaczanie obiektdw bazujgc na warto$ciach atrybutéw z tabeli atrybutéw. Obstuguje
sie jg z wykorzystaniem kreatora zapytan.

Kreator zapytan

Kreator (generator) zapytan jest zaawansowanym narzedziem pozwalajgcym
budowa¢ wyrazenia w QGIS. Jest on wykorzystywany w wielu miejscach m.in. do
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zaawansowanej selekcji wzgledem atrybutow, przy tworzeniu regut przy stylizacji czy do
ustawiania opcji etykietowania opartego o dane obiektow.

(2 Select by Expression - budynki_92 Xl
1 Wwyrazenie \-_Edytm
BELHL]E“;HLHZ“L”M Szukaj.. [ Show Help
> Data i czas
. B Ta grupa zawiera funkgje do
» Funkcje agregujace operowania na danych typu data i czas.
> General
Geometria
> Kolor
> Konwersja
> LuZne dopasowywanie
> Mapy wartosci
> Matematyczne
> Operatory
> Pola i wartosci
Rastry
> Tablice
> Tekstowe
> Warstwy mapy
Wiersz i atrubuty
> Wyrazenia warunkowe
> Zmienne
Podglad wyniku:
Fomoe | Fraybliz do obiektow | | £ Zazmacz obiekty [v| | zamknj

Z lewej strony okna kreatora znajduje sie pole tekstowe, w ktorym nalezy wpisac
wyrazenie. Nad nim znajdujg sie przyciski zawierajgce czes$¢ mozliwych do wykorzystania
operatorow.

Operatory stuzg do porownywania wartosci z warunkiem. Operatory matematyczne
stuzg do poréwnywania wartosci liczbowych. Operatory LIKE, ILIKE i % stuzg do
porownywania tekstéw. LIKE pozwala sprawdzi¢ czy dany ciag znakéw wystepuje w tekscie
np:

e ‘abcd’ LIKE ‘a’ - zwrdci false
e ‘abcd’ LIKE ‘a%’ - zwrdci true
e ‘abcd’ LIKE ‘“%b%’ - zwrdci true

Znak % zastepuje dowolny ciag znakdéw, dzieki czemu mozna wyszukiwac
wystepowanie ciggu znakéw w tekscie. Operator ILIKE dziata w ten sam sposéb jak LIKE,
ale nie zwraca uwagi na wielkos¢ liter.

Na prawo od pola tekstowego znajduje sie lista zawierajgca udostepniane przez
QGIS funkcje i zmienne, ktdre pogrupowane sg w kilka kategorii. Po wybraniu pozycji na
liscie pojawi sie krotki opis wraz z przyktadem uzycia. Podwdjne klikniecie na funkcji
spowoduje jej wstawienie w polu tekstowym.

e Grupa funkcji “Pola i wartosci” zawiera nazwy pdl danej warstwy. Po zaznaczeniu
nazwy pola mozna podejrze¢ unikalne wartosci, jakie sie w nim znajdujg (jesli jest
duzo obiektow mozna klikng¢ “Prébka” - nastapi wczytanie pierwszych znalezionych
wartosci co przyspieszy dziatanie).

e Grupa “Geometria” pozwala pobra¢ informacje o geometrii danego obiektu.
Przydatne zmienne z tej grupy to (zmienne zaczynajg sie symbolem $):

e $area - powierzchnia poligonu,
e S$length - obwdd poligonu lub dtugos¢ linii,
e S$x i $y - wspdtrzedne XY punktu (dla linii i poligonéw zwraca pustg warto$¢

NULL)
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Wartosci powyzszych zmiennych wyliczane sg dla uktadu wspotrzednych dane;j

warstwy, a nie ukfadu ustawionego dla projektu.

e Grupa “Matematyczne” to zbidr wielu przydatnych funkcji z réznych dziedzin
matematyki np. trygonometrii (cos, sin, atan), logarytmiki (In, log), algebry
(pierwiastek, potega) czy statystyki (max, min).

Funkcje wymagajq aby ich parametry miaty odpowiedni typ danych, dlatego czasem
przydatne jest wykorzystanie funkcji konwertujgcych z jednego typu do drugiego, np. tekstu
na liczbe lub date.

Operatory pozwalajg na wykonywanie operacji pomiedzy danymi. Wiekszos¢ z nich
stuzy do operacji matematycznych. Operator || stuzy do tgczenia dwoch tancuchéw znakdw
(plus nie dziata na tym typie danych):

‘ab’ + ‘cd’ -> btad
‘ab’ || ‘cd’ -> ‘abcd’

W polu tekstowym tahncuchy znakéw wpisujemy pomiedzy apostrofami ( ‘id’ ), nazwy
pol z tabeli w cudzystowie ( “id” ), a liczby, funkcje i zmienne bez zadnych dodatkowych
znakow.

W zaktadce “Edytor funkcji” istnieje mozliwos¢ tworzenia wiasnych funkcji w jezyku
programowania Python.

Przyktadowo, aby zaznaczy¢ gminy w powiecie bialskim o liczbie ludnosci powyzej 5
tys. osob nalezy w projekcie QGIS wskazac¢ jako aktywng warstwe “Gminy”. Nastepnie z

paska narzedzi wybra¢ “Zaznacz obiekty uzywajac wyrazenia” . W kreatorze zapytan
nalezy zdefiniowa¢ odpowiednie wyrazenie na bazie atrybutéw i wartosci. W Srodkowej
kolumnie nalezy rozwing¢ pozycje “Pola i wartosci” i wybra¢ pole “Powiat” ( dwukrotne
klikniecie wstawi je do wyrazenia), nastepnie wstawic¢ operator = (z pozycji “Operatory” lub z
klawiatury) i podac interesujgcg wartos¢ w apostrofach - w tym przypadku ‘bialski’.
Nastepnie dodac operator taczacy AND i analogicznie wprowadzi¢ drugi warunek: “Ludnosc”
> 5000. Wyrazenie w catosci powinno wyglada¢ nastepujaco:

=

(=3 Select by Expression - gminy

Wyrazenie Edytor funkcji

Szukaj.. | show values

=+ (-7 *

L) W
'POWIAT" = 'bialski' AND
"LUDNOSC" > 5000

General =
Geometria

Kolor

Konwersja

Kliknij dwukrotnie, aby dodac
nazwe pola do wyrazenia.
Kliknij prawym przyciskiem myszy
nazwe pola, aby menu kantekstowe
Luzne dopasowywanie tadowania przykladowych wartoéci
Mapy wartosci pola.
Matematyczne =
Operatory i
Ostatnio uzyte (Selection)
Pola i wartosci

abe GMINA_KOD

NULL

abc WOJ_KOD

abc POW_KOD

abc WOJ

abc POWIAT

abe GMINA

1.2 LUDNOSC
» Python
Rastry

(v v vvvwvvv~w

Wartosci | O Szuka

Jszystkie unikalr | 10 prébek

-

Podglad wyniku: 1

Pomoc Przybliz do obiektdw £ Zaznaz obiekty |* Zamknij

Aby zaznaczy¢ obiekty nalezy klikngé na przycisk “Zaznacz obiekty”.
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Kalkulator pol

Kalkulator pdl pozwala wykonywac¢ obliczenia na danych danego obiektu (atrybuty i
geometria) i wpisa¢ ich wynik w tabeli atrybutéw. Dane moga zostaé zapisane w istniejgcej
kolumnie lub nowo utworzonym polu. QGIS udostepnia bogaty zestaw funkcji i zmiennych,
ktére mozna wykorzystaé¢ w obliczeniach.

Dostep do kalkulatora mozna uzyska¢ z poziomu tabeli atrybutéw klikajac ikone

“Otworz kalkulator pél” . Okno kalkulatora podzielone jest na kilka czesci:
=

@ Kalkulator pol

| Aktualizuj tylko 7 zaznaczone obiekty

V| Twérz nowe pole Aktualizuj istniejace pole

Twdrz pole wirtuzine
Nazwa pola wyjéciowego

Typ pola wyjéciowego | Liceby catkouite (integer) -

Diugosé pola wyjsciowego | 10 < | Dokladnosé |3

Wiyrazenie | Edytor funkgji

Szukaj.. Shous Help
brak pomocy dla aquagis

S A e
row_number

aquagis

Data i czas

Funkcje agregujace

General

Geometria

Kolor

Konwersja

LuZne dopasowywanie

Mapy wartosci
Matematyczne

Operatorv b

Podglad wyniku:

Edytujesz informacje w tej warstwie, ale nie znajduje sie ona w trybie edycji. Jedli Kiikniesz OK, Zostanie automatyeznie wiaczony tryb
edycii.

o

oK Anuluj Fomoc

W goérnej potowie mozna ustawi¢ czy narzedzie ma zaktualizowac istniejgce pole
(nalezy je wybra¢ z rozwijanej listy) czy stworzy¢ nowe (trzeba ustawié¢ jego nazwe i typ
danych). Dodatkowo mozna zaznaczy¢ opcje aby zaktualizowane zostaty tylko atrybuty
zaznaczonych obiektéw. Pozostatg czes¢ okna stanowi kreator wyrazen opisany powyze;j.

Przyktadowo, aby obliczyé powierzchnie gmin w wojewoddztwie lubelskim nalezy
wybra¢ w projekcie aktywng warstwe “Gminy” i klikng¢ na pasku narzedzi przycisk “Otwérz
kalkulator pol’. W oknie kalkulatora zaznaczy¢ opcje “Twérz nowe pole” i wprowadzic¢
nazwe pola wyjsciowego np. “Pow_gminy”, okresli¢ typ pola na wyjsciowego na liczby
dziesietne z przyktadowg dlugoscia 10 znakéw i doktadnoscig 3 miejsc po przecinku.
Kolejno w s$rodkowej kolumnie rozwingé pozycje “Geometria” i wybra¢ funkcje “$area”
(dwukrotne klikniecie doda jg do wyrazenia):
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() Kalkulator pol g-&

V| Aktualizuj tylko 7 zaznaczone obiekty

V| Twérz nowe pole Altualizj istniejace pole
Twérz pole wirtualne

Nazvea pola wyjsciovego | Pow_gminy

Typ pola wyjéciowego | Liczby dziesietne (real) -

Diugos€ pola wyjsciowego | 10 % | Doktadnosé |3 -

Viyrazenie | Edytor funkgji

— Szukaj... Show Help =
ol s | M | ) L1 S
row_number =
Sareal v EiGE Zuraca poierzchmis biezacego
obiektu. Obszar obliczony za
» Dataiczas
) pomoca tej funkgji jest zgodny
+ Funkgje agregujace zaréwno z biezgcymi ustawieniami
» General elipsoidy w projekeie, jak i z
~ Geometria ustawieniami jednostki powierzchni.
angle_at_vertex Np. jesli dia projektu zostata
e ustawiona elipscida, wowczas
Sarea
obliczony abszar bedzie
i elipsoidalny, a jesi nie zostanie
azimuth ustawiona zadna elipsaida, to
boundary obliczony obszar bedzie Es
Podglad wyniku:  228064917.72561324 hounds >
é) Edytujesz informacje w tej warstwie, ale nie znajduje sie ona w trybie edycji. Jesli Klikniesz OK, zostanie automatycznie whaczony tryb
edygji.

oK Anuluj Pomoc

Catos¢ nalezy potwierdzi¢ przyciskiem “OK”. Po tej czynnosci warstwa przejdzie w tryb
edycji, a w tabeli atrybutoéw zostanie dodana nowa kolumna z obliczong powierzchnig gmin.

Panel statystyk

Wiacza sie poprzez menu “Widok” > “Panele” > “Statystyki’. Nastepnie w panelu
nalezy wybraé z listy rozwijalnej warstwe oraz atrybut, z ktérego majg by¢ liczone statystyki.
Ponizej pokazg sie wartosci dla podstawowych statystyk matematycznych z danej kolumny.

Statystyki {=2]E)

2 gminy -

1.2 LUDNOSC (| €
Statystyka Wartosé =

Liczba 196

Suma 1.5561e+06

Srednia 7939.27

Mediana 5377

Odchylenie standardowe {(pop) 247471

Odchylenie standardowe (sample) 24810.5

Minimum 1746

Maksimum 349440 =
Tylke zaznaczone obiekty B &S| .-
L Szukana fraza (Ctri+K) 0 obiektdw zaznaczonycH

taczenie tabel

Pozwala przypisywac¢ dodatkowe atrybuty do obiektéw wektorowych z innych, juz
istniejgcych tabel.

Aby potaczyé tabele z warstwg, nalezy otworzy¢ okno wilasciwosci warstwy
wektorowej i przejs¢ na zaktadke ,Zlgczenia’. Za pomocg przycisku “Dodaj nowe

i

ztaczenie” . W oknie dialogowym wskazujemy wszystkie pozycije:
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tabela - tabela, ktéra ma zosta¢ potaczona z warstwg,
pole tabeli - kolumna z tabeli z indywidualnym kluczem obiektu
pole ztgczenia - kolumna z warstwy z tym samym kluczem obiektu co wyzej
dotacz tylko wybrane pola - wybdér kolumn, ktére majg zostaé dotgczone do
warstwy
e prefiks nazwy pola - przedrostek nazwy dotgczanej kolumny

taczenia tabel dokonuje sie poprzez wybranie spojnych atrybutéw z jednej i drugiej
warstwy. Atrybutami powinny by¢ indywidualne kody przypisane do konkretnego obiektu np.
kod teryt, kod id, kod pocztowy. Nie zaleca sie tgczenia warstw po nazwach i opisach, gdyz
czasem kilka jednostek moze nosi¢ takg samg nazwe lub posiada¢ ten sam opis.

Po wykonaniu ztgczenia nowe kolumny zostang dodane na kohcu tabeli atrybutéw
warstwy wektorowej. Ztaczenie jest przechowywane w aktywnym projekcie - aby zapisaé
nowe kolumny na state w warstwie nalezy jg wyeksportowa¢ od nowego pliku.

Pomiary

Do szybkich pomiarow odlegtosci, powierzchni i katdw na oknie mapy stuzy

—

narzedzie “Pomiar” dostepne w pasku narzedzi EE ¥ po wybraniu odpowiedniej pozyciji

otworzy sie okno dialogowe. Aby wykonac¢ pomiar nalezy klikng¢ na przycisk “Nowy”, a
nastepnie na oknie mapy narysowac linie pomiaru klikajac jej wierzchotki lewym przyciskiem
myszy. Aktualne wyniki dla segmentu i sumy bedq sie wyswietlaty w oknie “Miara”.

Miara (3]
T

Segmenty [metry]
7474940478
4868325,322

Razem 12343265,800 m | metry -

b Informacje

| Howy || Ustawienia || Zamknij || Pomoc |

Aby wykona¢ pomiar obiektéw na warstwie wektorowej nalezy skorzysta¢ z
kalkulatora pdl i funkcji statych takich jak: $area, $length, $perimeter.

Przyktadowo, aby obliczyé powierzchnie gmin w wojewddztwie lubelskim nalezy
wybra¢ w projekcie aktywng warstwe “Gminy” i klikng¢ na pasku narzedzi przycisk “Otworz
kalkulator pol”. W oknie kalkulatora zaznaczy¢ opcje “Twoérz nowe pole” i wprowadzic¢
nazwe pola wyjsciowego np. “Pow_gminy”, okresli¢ typ pola na wyjsciowego na liczby
dziesietne z przyktadowg dlugoscia 10 znakdéw i doktadnoscig 3 miejsc po przecinku.
Kolejno w $rodkowej kolumnie rozwing¢ pozycje “Geometria” i wybraé funkcje “$area”
(dwukrotne klikniecie doda jg do wyrazenia):
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(&) Kalkulator p&l

V| Aktualizuj tylko 7 zaznaczone obiekty

V| Twérz nowe pole Altualizj istniejace pole
Twérz pole wirtualne

Nazvea pola wyjsciovego | Pow_gminy

Typ pola wyjéciowego | Liczby dziesietne (real) -

Diugos€ pola wyjsciowego | 10 % | Doktadnosé |3

o

Viyrazenie | Edytor funkgji

; L szukaj... Show Help =
Gl | | el I M B[R P L Funkcja $area
row_number =
Sareal v EiGE Zwraca powierzchrie biezacego
» D obiektu. Obszar obliczony za
ata i czas -
i pomoca tej funkdi jest zgodny
b Funkge agregujace Zaréwno z biezacymi ustawieniami
» General elipsoidy w projekeie, jak i z
~ Geometria ustawieniami jednostki powierzchni.
angle_at vertex Np. jesli dia projektu zostata
$area ustawiona elipsoida, wéwczas
obliczony abszar bedzie
i elipsoidalny, a jesi nie zostanie
azimuth ustawiona zadna elipsaida, to
boundary obliczony obszar bedzie Es
Podglad wyniku:  228064917.72561324 haunds. !
’\1‘) Egytu]ez informacje w tej warstwie, ale nie znajduje sie ona w trybie edycji. Jesli Kikniesz OK, zostanie automatycznie wiaczony tryb
edycji.
| ok || Anuw Pomoc

Catos¢ nalezy potwierdzi¢ przyciskiem “OK”. Po tej czynnosci warstwa przejdzie w tryb
edycji, a w tabeli atrybutoéw zostanie dodana nowa kolumna z obliczong powierzchnig gmin.
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Cwiczenie 7. Kompozycje kartograficzne

Tworzenie wydruku

Do sporzadzania wydrukdéw w programie QGIS stuzy kompozytor wydrukéw. Aby

doda¢ nowg kompozycje wydruku nalezy klikng¢ przycisk “Nowy wydruk” D na pasku
narzedzi lub w menu “Projekt” wybraé¢ pozycje “Nowy wydruk”. Po wprowadzeniu nazwy
wydruku otwiera sie nowe okno z kompozytorem wydrukéw. W owym oknie znajdujg sie trzy
zaktadki oraz pasek zadanh zawierajacy wszystkie opcje i mozliwosci wydruku.

W pierwszej kolejnosci nalezy przygotowaé arkusz do wydruku. Mozna to zrobic
klikajac prawym przyciskiem myszy na obszarze roboczym i wybierajagc pozycje
“Witasciwosci strony”. Mozna zmienic¢ tutaj ustawienia rozmiaru strony i orientacje papieru.

Aby doda¢ obiekt do wydruku korzystamy z jednego z narzedzi znajdujacych sie w
pasku po lewej stronie.

Uklad wydruku Edycja Widok Obiekty Dodajobiekt Atlas Ustawienia

BRCECR G @R (%
AL ARG BE O L bR
o I I I T N I 2 L N e e e N N

| bRt
& Dy

0 IR P [P e e

120 ‘

:ﬁ-cgn?éam‘ ol &FE M A ES ?1‘%52\\’@'

150| i ‘170‘

AL

x: 107 mm y: 0 mm strona: 1

W pierwszej kolejnosci po wybraniu przycisku "Dodaj mape" “ & nalezy zaznaczy¢
obszar na ktérym zostanie wyrysowana mapa w wydruku. Po dodaniu obiektu uaktywnia sie
zaktadka “Wtasciwosci elementu”, w ktérej ustawi¢ mozna szczegotowe wiasciwosci dla
kazdego dodanego obiektu. Wazne jest dostosowanie odpowiedniej skali mapy, tak aby w
catodci, lub interesujacym obszarze mieScita sie ona w wyznaczonej ramce. Zmieni¢ mozna
tutaj rowniez pozostate wtasciwosci elementow.
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Wiasciwosci elementu Uktad wydruku Atlas

Whasciwosci elementu (E1E3
Mapa 1

v Gldwne whasciwosci
Odswiez podglad
Skala 6373194 <
Obrét mapy 0,00¢ HEES
Uktad wspétrzednych | Uzyj uktadu wspdt ~
v | Rysuj dekoracje z okna mapy
v Warstwy
Ustavs motyw mapy | (nie wybrana) ¥ | €=,
Zablokuj warstvy o €

Zablokuj style dla warstw

w ZIasieg
Xmin -124691,221 =R
¥ min |-230125,816 <

Legende mapy dodaje sie do kompozycji narzedziem "Dodaj Iegendg"=5| i
nastepnie okresla sie obszar, gdzie ma sie ona znalezé. Nastepnie w zaktadce
“Witasciwosci elementu” zmieni¢ mozna jej elementy {j.: tytut, pozycje legendy, czcionki,
wielkosci i rozmiary elementéw. Wazne: aby edytowaé pozycje legendy nalezy odznaczyé¢
pole "Aktualizuj automatycznie" - nastepnie mozliwe jest dodawanie lub usuwanie pozyciji,
ich przesuwanie lub edytowanie nazw grup i symboli.

Wiadciwosci elementu Uktad wydruku Atlas

@
(]

Wiasciwosci elementu
Legenda

3

w Gléwne wiasciwosd

Tytut Legenda Q'fv
Wyrdwnanie tytutu | lewa v
Mapa Mapa 1 ¥

Zawijaj tekst na

/| Dopasuj, aby zmiescic zawartosc

¥ Elementy legendy
| Aktualizuj automatycznie | Aktualizuj wszystko

* . PomnikiPrzyrodyPoint
© gtaz narzutowy
’ krzew
V¥ irodio
~ (2 ParkiNarodowePolygon
Z Kampinoski Park Narodowy
D Kampinoski Park Narodowy - ...
L] powiaty
n wojewodztwa

Grafiki do kompozycji wydruku dodaje sie narzedziem "Dodaj obraz" i nastepnie
okresleniem obszaru, gdzie ma by¢é on potozony. Nastepnie we “Witasciwosciach
elementu” nalezy zdefiniowaC zrédto obrazu poprzez wskazanie jego lokalizacji na dysku
komputera. QGIS posiada wtasng biblioteke znakéw SVG, ktére zazwyczaj znajdujg sie w
folderze z programem pod nastepujaca sciezka: /apps/qgis-Itr/svg/. Wsrdd nich znajduijg sie
rowniez strzatki potnocy, ktére rowniez mozna dodawaé z innych zrodet (np.
http://www.freepik.com/). Ponadto we wtasciwosciach obiektu mozna wyedytowaé pozostate
cechy dodanego obrazu.
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Aby utatwié tworzenie kompozycji opartych na podobnych elementach QGIS stworzyt
mozliwos¢ zapisywania elementow wydruku do szablonu i wczytywanie ich w nowo
tworzonej kompozycji. Aby zapisa¢ wydruk do szablonu nalezy wybra¢ z menu “Ukiad

wydruku” pozycje “Zapisz jako szablon” i oraz wskaza¢ miejsce na dysku, gdzie plik z
szablonem ma zostac utworzony.

Aby doda¢ elementy z szablonu do nowego wydruku nalezy wybra¢ z menu “Uktad

wydruku” pozycje “‘Dodaj obiekty z szablonu” . Po zlokalizowaniu wczesniegj
zapisanego pliku wczyta¢c go do programu, po czym wszystkie elementy automatycznie
zostang dodane do kompozyciji.

Kompozytor daje mozliwo$é automatycznego tworzenia mapki pogladowej, na ktorej
znajduje sie zasieg obszaru widniejgcego na gtéwnej mapie. Aby uzyska¢ nowy podglad
nalezy dodac kolejng mape do wydruku przyciskiem "Dodaj mape" i nastepnie po okresleniu
jej ustawien, we wtasciwosciach elementu rozwingé pole "Mapy podgladu” i za pomoca

przycisku Q doda¢ nowy podglad. Uaktywni sie wtedy pole "Rysuj podglad", w ktérym
nalezy ustawi¢ ramke mapy, dla ktérej ma by¢ wyswietlany podglad (gtéwna mapa) oraz
zdefiniowa¢ styl i inne elementy podgladu. Po tych zabiegach na mapie podgladu
podswietlony zostanie obszar ujety na mapie gtowne;j.

Wiasciwosci elementu Uldad wydruku Atlas

Wiasciwosci elementu @6
Mapa 2

¥ Mapy podgladu
o) = A v
Podglad 1

-

¥ | Rysuj podglad "Podglad 1"
Ramka mapy Mapa 1 -
Styl ramki .

Tryb renderowania | zwykty >
Odwrdc podglad
Wycentruj w podgladzie

Tworzenie kilku map (sekcji) odbywa sie za pomocg zakfadki “Atlas”. Pozwala ona
na stworzenie kilku arkuszy map bez koniecznosci tworzenia nowych wydrukéw, badz
recznego przesuwania obszaru mapy.

W celu stworzenia atlasu nalezy w owej zaktadce zaznaczy¢ opcje "Generuj atlas",
po czym w aktywnym polu "Konfiguracja" wybra¢ warstwe opracowania (warstwe
wektorowa dzielgcq catkowity obszar na mniejsze sekcje badz arkusze).
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Wiasciwosci elementu Uktad wydruku

Atlas
V| Generuj atlas

w Konfiguracja

Ukryj warstwe opracowania

Filtruj
Sortuj wedtug
w Zapisywanie

Nazwa pliku wynikowego (wyrazenie)

output '||@atlas _fe

+ Eksportuj jeden plik jesli to mozliwe

Formatu eksportu obrazu | png

Warstwa opracowania | L= wojewddztwa

Nazwa strony |abc jpt_nazwa_|

Atlas

Kolejno nalezy uaktywni¢ okno z mapag gtébwnag i we wiasciwosciach elementu
zaznaczy¢ pole "Kontrolowane przez atlas" - uaktywni sie menu, na ktérym mozna
zdefiniowaé czy program ma sam dobiera¢ najlepszg skale do arkusza, czy ma by¢ ona
stafa i identyczna dla wszystkich arkuszy.

Wiasciwosci elementu
Mapa 1
v V Kontrolowane przez Atlas

® Margines wokot obiektu

Stata skala

Wihasciwosci elementu Uktad wydruku

Predefiniowane skale (najlepiej pasujaca)

Atlas
B

-

10%

Po okresleniu wszystkich ustawien atlasu mozna przejs¢ do paska menu skad nalezy
wybrac pozycje "Atlas" i nastepnie "Podglad atlasu". Daje to mozliwos¢ przetgczania sie

pomiedzy kolejnymi stronami atlasu za pomoca narzedzi nawigacji e € & 9 ‘ w
celu sprawdzenia poprawnosci arkuszy.
Aby wygenerowa¢ atlas do pliku nalezy z paska narzedzi wybra¢ “Eksportuj Atlas”

I:E; Z listy rozwijalnej nalezy wybra¢ format pliku, a nastepnie w nowym oknie
dialogowym wskazan nazwe lokalizacje pliku na dysku. Po kliknieciu “Zapisz” program

rozpocznie generowanie atlasu.
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Cwiczenie 8. Analizy przestrzenne

Wektorowe

Umozliwiajg tworzenie nowych danych wektorowych na bazie istniejgcych. Wyrdznia

sie nastepujace narzedzia do analiz przestrzennych w QGIS, ktére sg dostepne z poziomu
menu “Wektor” > “Narzedzia geoprocesingu”:

1.

Otoczka wypukta [Convex hull(s)] — dzieki tej opcji powstaje nowa warstwa, ktora
stanowi najmniejszy mozliwy poligon okalajacy wszystkie poligony danej warstwy lub
poligony o konkretnym atrybucie. Stosuje sie jg m.in do tworzenia statystyk oraz
wyznaczania zakresu danego zjawiska.

Wykonanie:

wskaz warstwe zrodtowg > okresl format zapisu warstwy wynikowej > kliknij przycisk
“Uruchom”

Bufor [Buffer(s)] — tworzy nowy poligon poszerzony dodatkowo o wyznaczong
odlegtos¢. Jest to czesto uzywana opcja przy wytyczaniu stref ochronnych lub
oddziatywania danego zjawiska.

Wykonanie:

wskaz warstwe zrédtowg > okresl odlegtos¢ buforu w wybranej jednostce > zdefiniuj
ilos¢ segmentéw (dokltadnos¢ bufora) > wskaz styl zakonczenia i potaczenia >
zdecyduj o agregaciji (potgczeniu) buforow > okresl format zapisu warstwy wynikowej
> kliknij przycisk “Uruchom”

lloczyn [Intersects] — przy zastosowaniu tej opcji dostaje sie warstwe zawierajacg
obiekty posiadajace cze$¢ wspolng. Warstwa wyjsciowa zawiera atrybuty obu
warstw. Funkcje stosuje sie podczas naktadania na siebie dwoch warstw, gdy
waznym jest nadpisanie atrybutow.

Wykonanie:

wskaz warstwe zrédtowg > wskaz warstwe naktadki (do poréwnania) > wskaz pola z
warstwy wejsciowej i z warstwy naktadki, ktére majg zosta¢ zaimportowane do
warstwy wynikowej > okresl format zapisu warstwy wynikowej > kliknij przycisk
“Uruchom”

Suma [Union] — jest to zsumowanie dwéch warstw wejsciowych, gdzie dodatkowo
nowa warstwa wyjsciowa zostaje pocieta przez granice obu warstw, a ich atrybuty
zostang zaimportowane. Najczesciej Sume wykorzystuje sie podczas dodawania
kolejnych tworzonych warstw do wiekszej warstwy gtowne;j.

Wykonanie:

wskaz warstwe zZrodtowg > wskaz warstwe naktadki (do dotaczenia) > okresl format
zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

Réznica symetryczna [Symetrical difference] — podczas tej operacji otrzymuje sie
warstwe wynikowg zawierajgca wytacznie obiekty, ktére nie sg wspodlne dla warstw
wejsciowych. Mowigc inaczej — zostang usuniete czesci wspdélne. Kolumny obu
plikbw zostajg nadpisane w warstwie wynikowe;.
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Wykonanie:
wskaz warstwe zrodtowag > wskaz warstwe naktadki (do réznicy) > okresl format

zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

Przytnij [Clip] — jest to bardzo podobna opcja do Réznicy symetrycznej, jednak w
tym przypadku nie zostang zaimportowane atrybuty z warstwy przycinajacej. Z
pozoru opcje te sie nie réznig, poniewaz na ekranie otrzymujemy identyczng warstwe
wynikowa. Jednak w kontekscie analizy wektorowej réznica jest znaczaca. Funkgciji tej
uzywa sie zazwyczaj, gdy chce sie z duzego obszaru wycig¢ niewielkg jego czesc,
ktéra postuzy do dalszej analizy.

Wykonanie:

wskaz warstwe zrodiowag > wskaz warstwe nakladki (maske przyciecia) > okresl
format zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

Roéznica [Difference] — otrzymuje sie warstwe wynikowa, ktéra zawiera tylko obiekty
nienalezace do warstwy wycinajgcej. Warto zaznaczy¢, iz dane warstwy wycinajace;j
w tabeli atrybutéw nie sg nadpisane do nowego obiektu. Opcjg postuguje sie np.
podczas wyznaczania obszarow, ktére nie sg zagrozone wystepowaniem danego
czynnika/zagrozenia, rozpatrujac szersze granice przestrzenne.

Wykonanie:

wskaz warstwe zrodtowg > wskaz warstwe naktadki (do odjecia) > okresl format
zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

. Agreguj [Dissolve] — opcja taczaca obiekty danej warstwy posiadajgce ten sam

atrybut. Obiekty zostang potaczone, nawet gdy ich granice nie tgczg sie ze soba.
Taki obiekt moze by¢ fizycznie na mapie roztaczny, jednak w tabeli atrybutéw
warstwy wyjsciowej zostanie oznaczony jako jeden. Funkcja przydatna m.in. podczas
tworzenia danych statystycznych.

Wykonanie:

wskaz warstwe zrodtowg > opcjonalnie okresl atrybut, po ktérym majg zostac
zgrupowane obiektu > okresl format zapisu warstwy wynikowej > kliknij przycisk
“Uruchom”

Eliminuj szczatkowe poligony [Eliminate silver polygons] — dzieki niej pozbyé
mozna sie bteddéw topologii, poprzez usuniecie poligondéw wyrdzniajacych sie
znacznymi dysproporcjami wzgledem reszty. Opcja taczy miniaturowe poligony z
sgsiednimi o najwiekszej powierzchni albo najdtuzszej wspolnej granicy.

Wykonanie:

wskaz warstwe zrédtowg > wskaz opcje do ztgczenia zaznaczonych z sgsiadujgcym
poligonem > okres| format zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

Rastrowe

Umozliwiajg tworzenie nowych danych rastrowych na bazie istniejgcych zbioréw.

Wyrodznia sie nastepujace narzedzia do analiz przestrzennych w QGIS:

Ekspozycja — dzieki tej opcji powstaje nowa warstwa, zawierajgca wartosci katowe
zwrocenia danego stoku wzgledem stron Swiata. Ekspozycja jest liczona od kierunku
wschaod i jest obliczana odwrotnie do kierunku wskazéwek zegara.
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Wykonanie:

wejdz w menu “Raster” > “Analiza” > “Ekspozycja” > wskaz warstwe wejsciowg >
okresl liczbe kanatéw dla rastra > wybierz profil kompresji (zmniejszenia rozmiaru
rastra) > okresl| format zapisu warstwy wynikowej > kliknij przycisk “Uruchom”
Cieniowanie — tworzy raster z cieniowanym obrazem rzezby terenu, wykorzystywany
gtdwnie przy symbolizacji numerycznych modeli terenu.

Wykonanie:

wejdz w menu “Raster” > “Analiza” > “Cieniowanie” > wskaz warstwe wejsciowg >
okresl liczbe kanatéw dla rastra > zmniejsz mnoznik skali osi Z dla wygtadzenia
rezultatu > okre$l azymut Swiatta oraz wysokos¢ swiatta nad horyzontem > wybierz
profil kompresji (zmniejszenia rozmiaru rastra) > okre$l format zapisu warstwy
wynikowej > kliknij przycisk “Uruchom”

Nachylenie — tworzy warstwe z procentowg lub stopniowa wartoscig spadku dla
danego stoku.

Wykonanie:

wejdz w menu “Raster” > “Analiza” > “Nachylenie” > wskaz warstwe wejsciowg >
okresl liczbe kanatéw dla rastra > opcjonalnie wskaz opcje do zwrdcenia wynikow w
procentach zamiast stopni > wybierz profil kompresji (zmniejszenia rozmiaru rastra) >
okresl format zapisu warstwy wynikowej > kliknij przycisk “Uruchom”

Interpolacja — pozwala tworzy¢ dane ciagte (rastrowe) na bazie istniejgcych danych
wektorowych. Opiera sie o metode IDW (metoda Sredniej wazonej odlegtosci -
wylicza wartos¢ dla kazdej komorki na podstawie wartosci punktow wazonych
odwrotnoscig ich odlegtosci, w efekcie, czym bardziej jest punkt oddalony, tym
mniejszy jest jego wplyw na interpolowang wartosé¢) i TIN (metoda regularnych
trojkatow - sagsiadujace punkty sg tgczone liniami i w efekcie powstaje siatka
nieregularnych tréjkatow).

Wykonanie:

wejdz w menu “Processing” > “Panel algorytméw > “Interpolacja” > “Interpolacja
IDW” > wskaz wektorowg warstwe wejsciowg > wskaz atrybut do interpolacji > kliknij

na przycisk s aby dodac¢ atrybut do listy > okre$l liczbe wierszy i kolumn dla

rastra wynikowego > wskaz zasieg rastra wynikowego > okresl format zapisu
warstwy wynikowej > kliknij przycisk “Uruchom”
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